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WHAT IS WEB-ONE? 

Web-One is CSUN's unified approach to improve accessibility and navigation and increase consistency 
throughout CSUN’s web presence through the use of templates, guidelines, and web design standards. 
 
Using the Web-One content management system to create and maintain CSUN webpages should make 
it easier to keep content current on the CSUN website. 
 

Benefits of Web-One 

 No experience in web design or web development is required to use Web-One 

 Knowledge of web programming language is not necessary 

 Web-One tools are accessible from anywhere, anytime and anyplace via an Internet connection 

and Web browser 

 Workflow in Web-One provides additional editing opportunities so web content can be reviewed 

before being published 

 Predesigned templates generate webpage layouts, making it easier to create consistent looking 

webpages 

GROUPS 

A Group in Web-One can be a department, college, or division (e.g. Math, Humanities, Information 
Technology). 
 
ROLES FOR WEB CONTENT OWNERS 

There are four different roles in Web-One: Group Administrator, Content Creator, Content Editor and 

Content Publisher. Web content owners create, edit or publish content depending on the access granted 

for that role. You may have multiple roles. 

Group Administrator 

A Group Administrator can manage group settings and membership, but cannot edit content. 

Content Creator 

A Content Creator has the ability to create content pages and edit their own content. The Content 
Creator cannot publish their content. 
 

Content Editor 

A Content Editor can create and edit content pages and edit the content of others. 

Content Publisher 

A Content Publisher can create, edit and publish content regardless of the owner. A publisher also has 

the ability to go back to historical content of any type. 
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1. Log in to the Portal using your CSUN Username and Password. 

2. Go to the Web-One pagelet 

3. Select the Content Owner Login link to log in as a content owner.  

       

Note: If you do not see the Web-One portal pagelet, go to http://www.csun.edu/saml_login and login with 

your CSUN username and password. 

COMPATIBLE BROWSERS & POP-UP BLOCKERS 

Choose from one of the following supported browsers:  

 Internet Explorer 8 or 9 

 Firefox 14 

 Safari 5 

 Chrome 13 and 22 

Note: Remove pop-up blockers to ensure proper Web-One functionality.  

  

http://www.csun.edu/saml_login
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Your group landing page is the first page that most users will see when they navigate to your site. The 

group landing page in Web-One is compiled of several design elements and content types that are 

compiled in various areas of Web-One. A brief overview of the group landing page will provide critical 

insight into the use of themes, content types, and the organization of data in Web-One. The details 

needed to create these elements will be covered throughout the rest of the user guide. 
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Group Landing 

Page Template 

Description 

Header Consistently used on all CSUN web pages and includes CSUN word 

marks and links to utilities (e.g. accessibility, PeopleFinder). 

Primary Navigation 

Bar 

Customizable with up to 7 direct links to other webpages. 

Banner Customizable with one image or up to 6 images that rotates 

automatically every 5 seconds or manually controlled by the viewer. 

Constituency 

Navigation Bar 

(Optional) 

Customizable direct links to reach webpage constituents (e.g. students, 

staff, faculty, alumni, prospective students). 

Left Column Content 

Section (Optional) 

Column for additional content (text, links, images and video). The Center 

Content will expand to fill this space if there is no content. 

Center Column 

Content Section 

Main section to display general information, plus News and Events. 

Right Column 

Content Section 

Column for additional content (text, links, images and video). The Center 

Content will expand to fill this space if there is no content. 

Footer Consistently used on all CSUN web pages and includes privacy policy, 

emergency information, etc., plus two optional group links. 
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NAVIGATING THE WEB-ONE INTERFACE 

As a CSUN web content creator the My Workbench tool helps you navigate throughout the system 
Using the WYSIWYG Text Editor (see page 80 for more information). To start, select the My Workbench 
button. If you lose your place when working on content, you can always start over at the My Workbench 
page by selecting the My Workbench button.  

My Workbench 

My Workbench is the main starting point for CSUN web content owners to create, edit and publish 

content.   

When My Workbench is selected, it defaults to the Site Content tab. Site Content is where you can 

find and edit unpublished or published webpages. This tab is also used to search for content using the 

field and dropdown menus to narrow the search. 
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My Workbench Tabs 

Additional tabs in the My Workbench page display in the upper right. These tabs display different pages 

of information in the system. 

 
 

Site Content:  Displays a list of all unpublished and published webpages in the system. 

Create Content: To create a webpage, select the Create Content tab and choose the applicable 

     content type to create a webpage. 

File list:  Files such as audio clips, images and video clips are uploaded and displayed in 

     the File list tab. This tab displays the files from every group, so this tab can 

     contain several pages of files.  

My Content:  A list of webpages (content) displays on the My Content tab. Content can be 

     searched using the Title field and the dropdown menus to narrow the search. 

Needs Review: On this tab, a creator or editor will see a list of their content pages waiting for 

     review. A publisher will see a list of pages waiting to be approved to publish.  

Navigating to the Group Landing Page in Web-One 

1. Log in to Web-One. 

2. Select the Group Membership link for your group. 

 

Note: this user has access to more than one group landing page.  
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CHANGING WEBPAGE LAYOUT 

Panelizer is the tool that lets you choose the webpage layout (e.g. one column, two column or three 
column) and create the links to display on the left and right columns for the two and three column layout.  
Each new webpage defaults to a one-column layout.  
 
Layout is configured in the Panelizer tab. Panelizer allows you the flexibility to choose different layouts 
for basic pages as well as Events, News and Video pages.  You can add, remove and create various 
pieces of content using Panelizer.  

Layout Examples Using Panelizer 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

ONE COLUMN LAYOUT  

THREE COLUMN LAYOUT, 

DISPLAYS LEFT AND RIGHT 

COLUMN 

TWO COLUMN LAYOUT, 

DISPLAYS LEFT COLUMN 

Navigating to Panelizer 

1. To access the Panelizer, from the My Workbench page select the title of the page that requires 
layout or left/right sidebar editing. 
 

    



TEST 

 

Web-One Essentials - User Guide      Page 12 of 127 
12/04/19         

 

2. Select the Panelizer tab. 
 

 
 
3. Select the content link. 

 

 
 

Using Panelizer 

The Panelizer content 

screen displays. To 

change the title of the 

webpage, you can enter a 

new title in the Title field.  

To add a two or three 

column layout to the page, 

content must be added to 

the left or right sidebar. 

When a sidebar is left 

blank (see the Right 

sidebar as an example) 

a column doesn’t display. 

When selected, 

the Gear icons on 

the Panelizer 

content screen allow you 

to add content to the 

page. 
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Creating a New Side Block 

1. To create a new side block select the Side block link from the window. 

 

 
 

2. The Configure new Side block window displays. Enter the information (as needed) into the 

fields. For advanced users, select the dropdown menu to find a Filtered HTML text format 

available. For more information on text formatting select the More information about text 

formats link.  

 
 

3. To make the side block reusable, from the same Configure new Side block window, select 

the Make this entity reusable checkbox. 

 

 
 

4. Once the fields are filled out, select the Save button on the main Panelizer content screen. 
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Adding Sidebar Content to Create Different Page Layouts 

1. Select the Gear icon from the Left Sidebar, Content or Right Sidebar. 

2. An Add Content menu displays. Select the menu to view an additional window to add, remove 

or move pieces of content. 

 

 
 

3. The sidebar or content menu displays. Select an existing side block from the list to add content. 

 

This example displays the 

Contact Us block side block 

after it was added to the page. 

This created a two column page 

layout. 
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Editing, Deleting or Disabling Sidebar Content 

1. From the the main Panelizer content screen, select the gear next to the sidebar content (image 

shows a block) that requires editing, deleting or disabling. Choose the appropriate option from the 

menu. (Disabling this pane hides the sidebar content that is selected). 

 

 

Note: Editing an existing side block will impact any pages referencing that side block. 

Adding a Mini Calendar to a Page 

1. In Paneizer, select the Gear icon from the Left Sidebar or Right Sidebar. 

2. An Add Content menu displays. Select this menu to view an additional menu to add, remove or 

move pieces of content. 

         

3. Select Calendar from the content menu.  

4. Select View: Calendar – Events; CP Month Mini. 

      

5. Select the Finish button. 

6. In Panelizer, select the Gear icon for the Center panel. A second component must be added to 

made the mini calendar functional and this component must be added to the center panel.  
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7. Select Calendar from the content menu.  

8. Select View: Calendar – Events; CP Events Upcoming. Your panelizer page should look 

something like this: 

     

9. Select the Save button to save changes. View the page to see changes. If you need to 

resposition the calendar, drag and drop it to its desired location in panelizer. 

Adding a Calendar Grid to the Center of a Page 

1. In Panelizer, select the Gear icon from Center panel. 

2. An Add Content menu displays. Select this menu to view an additional menu to add, remove or 

move pieces of content. 

       

3. Select Calendar from the content menu.  

4. Select View: Calendar - Events; CP Month Full.  

      

5. Select the Finish button.  

6. In Panelizer, select the Save button to save changes. View the page to see changes.  
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Adding a Divider Line to a Page 

1. In Panelizer, select the Gear icon from the Center panel. 

2. An Add Content menu displays. Select this menu to view an additional menu.  

3. Select Miscellaneous.  

4. Select Divider.  

       

5. Select the Finish button.  

6. Select the Save button to save changes. If you need to reposition the divider to a different 

location, drag and drop it to its desired location in panelizer.  

Example of page with a divider line: 
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Adding Breadcrumbs to a Page 

Breadcrumbs add an additional method of navigation to a website. The breadcrumb links can help you 

navigate back through a website without using the back button on the browser. 

 

1. Select a page you want to add a breadcrumb to and select the Edit link, followed by the 

Panelizer tab. 

 

2. Select the Content link. 

3. From the Content column, select the Gear icon followed by the Add content option.  

 

4. Find and select the Page Elements link.  

5. Select the Breadcrumb link. 

6. The Breadcrumb element displays in the Content column. Drag and drop the element to the 

location where you want your breadcrumb to display. 

7. Select the Save button. 

Adding a Person A to Z Listing to a Page 

Using the panelizer, you can add a person A to Z listing with or without photos through the content pane. 

The content pane of a general page is the only place you should add the Person A to Z listing. 
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A person A to Z listing without photo. 

 

A person A to Z listing with photo. 

 

1. Select a page you want to add the Person A to Z listing and select the Edit link, followed by the 
Panelizer tab.  
2. Select the Content link. 
3. From the Content column, select the Gear icon followed by the Add content option.  
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4. On the left-hand side of the window, locate the Person A to Z from the list of category options. 

 
 
5. Choose the Person A to Z list with or without a photo.

 
 
6. Select your group you are creating the Person A to Z listing for.  
 

 
 
7. Your page displays the Person A to Z list.  
 

 
 
8. View your page with the Person A to Z listing by select the View tab.  
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Tabs Layout 

A Global Administrator can assist a publisher, editor or creator in creating a tabs layout for a page. To 

enable this feature, contact the Help Center at x1400. 
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 A webpage can contain many types of content, such as informational content, news items, lists of 

people, etc. In Web-One, a content type is a pre-defined collection of data types which relate to each 

other. For example, webpage showing news items will be created using a news item content type which 

includes a specified layout for the titles, spacing, placement of images and wording on the webpage. 

The initial release of Web-One contains several content types, including Event, News, Page, Person, 

Slideshow, Video and Webform.    

Descriptions and instructions on how to create each type of content is included in pages 23-93.   

Content Types 
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CREATING A SLIDESHOW (BANNER) 

A Slideshow displays a series of up to six images with brief pauses in between each image, immediately 

below the primary navigation bar. All Group “landing pages” are required to have a slideshow of at least 

one image.  

A slideshow is optional for all other pages in your Group site. Slideshows can include one (static image) 

or up to six images in a rotating slideshow. Different slideshows can be used throughout your Web-One 

Group site. Slideshows have a space designated for a title and subtitle. The title wording can be linked to 

a URL. 

 

 

 

 

* Denotes required information  

A SLIDESHOW DISPLAYING ALL OPTIONS 
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1. From the My Workbench page, select the Create Content tab. 

2. Select the Slideshow link. 

 

Creating a Slideshow 

The Create Slideshow page displays. Complete and or review the following. 
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Create Slideshow fields Description 

Title (*) The title for the Slideshow. 

Slides This section is used to create individual slides. The Slides fields 

are used to add extra information about each individual slide. 

(*) = Required 
 

1. On the Slides section of the Create Slideshow page, review the following fields. If you leave 

these fields blank, your image displays without a title or URL. 

Slides Fields Description 

Slide image The image that will be displayed on that individual slide. Use the Select 

Media button to select an image from one of the available libraries. The 

recommended dimensions for the slide images are (600, 400 or 336) 

pixel height and (1128) pixel width. 

Slide title The title of that individual slide. 

Slide link title The title of the slide link. It is limited to 128 characters maximum.  

Slide link URL The actual URL of the link. 

 

 

Select the Add another item button if you want to add another individual slide to the slideshow. 

Note: To create a blank slideshow, complete the title field and leave the slides fields empty. 

  



TEST 

 

Web-One Essentials - User Guide      Page 26 of 127 
12/04/19         

 

2. By default the Groups tab is selected. Complete the following: 

 

Groups option Description 

Groups audience (*) This is a required field. Use the dropdown to specify which group this 

Slideshow is visible. If you only have access to one group, then that group 

will appear by default.  

(*) = Required 
 

3. Select Revision information. 

 

Revision Information Field Description 

Change State (*) This dropdown is used to select the revision status: Draft or 

Needs Review. What appears in this dropdown is determined by 

your permissions.   

(*) = Required 
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4. Select URL path settings. 

 

URL Path Settings Description 

URL alias This field is used to manually add a customizable URL alias for the 

slideshow. 

 

5. Select the Save button to save and view the content you just created.  
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The Events content type enables you to inform others about upcoming events. Events can be viewed in 

a list with a lede (teaser), encouraging a reader to view more about that particular event which is 

available on an event page.  

Selected events can be chosen to display as “featured events” which will display at the top of the event 

list by date. You can choose to have featured events display on your Group landing page or any other 

page in your site.   

Events require a date, time, location, lede text (or teaser) about the event, and body of text describing 

the event. Additional options enable you to include an image or slideshow and a deck (or introduction). 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

AN EVENT FEATURED ON THE GROUP LANDING 

PAGE 

AN EVENT DISPLAYING ALL OPTIONS FOR THE EVENT 

CONTENT PAGE 
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Navigating to the Event Page 

1. From the My Workbench page, select the Create Content tab. 

2. Select the Event link.  

 

Creating an Event Page 

The Create Event page displays. 
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1. By default the Event Info tab displays. Enter information (as needed) into the following fields: 

Event Info Fields Description 

Title (*) The title for the event.  

Date/Time (*) The date and time for the event. Select the date field to choose from a 

calendar. Use military time when entering time.   

Location (*) Enter a location for the event.  

Cost If applicable, enter the cost information for the event.  

Registration If applicable, enter a registration link (URL) for the event.  

Event Category Select an event category. This not is not a required field, but may be 

used to filter events should you choose to do that.  

(*) = Required 

2. Select Lede and complete or review the fields. For additional information on how to use the text 

editor see Using the WYSIWYG Text Editor. 

Lede Fields Description 

Lede (*) The lede is a teaser for the event and is a required field.  

Text format This field allows you to select the text format for your lede.  

Lede image The lede image is the image that displays along with the lede (teaser). 

Use the Select Media button to select an image from one of the 

available libraries.    

 

(*) = Required 
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3. Select Deck and Body and complete and or review the following fields: 

 

Deck & Body Fields Description 

Deck This is an optional field that displays information above the main 

body of the page.   

Text format This field allows you to select the text format for your deck and 

body. 

Deck image The deck image is the image that displays along with the deck. 

Use the Select Media button to select an image from one of the 

available libraries.    

Deck image caption Enter a caption for the image.  

Body (*) This field is a required field. The body is the information that 

highlights and describes the event.  
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4. Select Misc and select the following: 

 

Misc Fields Description 

Banner 

Slideshow 

Select the banner slideshow that should be shown on this page. A blank 

slideshow can be used if you do not want any slideshow on this page. 

This slideshow is the rotating images that appear at the top of a page.  

“Read More” 

replacement 

Insert accessible text that replaces the “Read more” link that displays 

when the Event is published. 

 

5. Select Groups: 
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Groups Field Description 

Groups audience (*) This is a required field. Use the dropdown to specify which group 

this event belongs. If you only have access to one group, then 

that group will appear by default.  

(*) = Required 

Menu Settings  Description 

Menu setting checkbox Checking this box adds a menu link.  

6. Select Menu settings.   
 

  

 

7. Select Flags. 
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Flags  Description 

Feature this checkbox Checking this box features the Event item on any pages 

referencing the featured Events.  

8. Select Revision information.  

 

Revision Information Fields Description 

Change State (*) This dropdown is used to select the revision status: Draft, 

Needs Review or Published). What appears in this 

dropdown is determined by your permissions.   

(*) = Required 

9. Select the Save button to save and view the content you just created.  

Categorizing and Adding Tags to an Event 

A set number of categories display once an event is created. Categories help sort events. If a category is 

too broad, adding a tag can be helpful to sort. Tags allow an event to be described using an additional 

label. For example, if the category of Professional Development is too broad, you can add a tag called, 

Moodle Workshop, to be more specific and help describe what Professional Development means. Do not 

mistake tags for metatags; tags are not used for searching content. 

1. On the Event Info tab, select the category or categories that fit your event. 
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2. Below the category checkboxes, enter up to three tags. Separate any tags with a comma. Once a tag 

is created other users can see and use the same tag.  

NOTE: Create and use tags carefully. 

 

Adding Category and Tag Listings to a Sidebar 

Once a page is created you can add categories, tags or a display both listings on a sidebar of a page.   

1. Select a page in Web-One and choose the Panelizer tab. 

2. Choose the Content link. 

3. Select the left or right gear icon in either sidebar. 

 

4. Choose the Calendar link from the list on the lefthand side. Select an option to display the list of 

Categories, Tags or display both Categories and Tags. 

5. Select the Finish button and Save the configuration.  

Sharing a New Event with Another Group 



TEST 

 

Web-One Essentials - User Guide      Page 36 of 127 
12/04/19         

 

There are a lot of events throughout campus and you may want to share an event on your Event Listing 

page from a different area. Sharing an event will display another group’s event on your Event Listing 

page. 

*Please note that if an event is shared with another group and the group deletes the event, it 

will be permanently deleted. 

1. Log in to Web-One. 

2. Select the My Workbench button. 

3. Select the Event link from the Create Content tab. 

4. Insert a Title and all other required and pertinent information about your event. In the Invite 

Groups tab, select the groups you want to share your event with. To select more than one group, 

hold the Ctrl key down.  

NOTE: The Event must be published for other departments to view and add the event to their 

Event listing page and Event calendar. 

 

Note: To request that your event display on the university calendar, University Advancement will review 
your event and verify it meets the following criteria: 
 
1. Include a custom lede image. 
 
2. Accurate and error free information. 
 
3. Include a statement such as, "All are Invited", this includes external community. 
 
Note: The group admin for the group/s selected do not get email notifications indicating that an event has 
been shared. Please contact them directly to let them know. They must manually go into their Group tab 
> Event Sharing Invitations to accept the event. 
  



TEST 

 

Web-One Essentials - User Guide      Page 37 of 127 
12/04/19         

 

 

Sharing an Existing Event 

1. While logged in, open up the event you want to share and select the Edit Draft tab.  

2. Select Invite Groups from the menu on the left.  

3. Select the group that you want to share the event with. Hold the Ctrl key down while selecting to 

share with more than one group.  

4. Add a notation if desired. 

5. Press the Save button.  

Note: The group admin for the group/s selected do not get email notifications indicating that an event has 

been shared. Please contact them directly to let them know. They must manually go into their Group tab 

> Event Sharing Invitations to accept the event.  

Note: To request that your event display on the university calendar, University Advancement will review 
your event and verify it meets the following criteria: 
 
1. Include a custom lede image. 
 
2. Accurate and error free information. 
 
3. Include a statement such as, "All are Invited", this includes external community. 
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CREATING A NEWS ARTICLE 

The News content type enables you to inform others about news, current information, or 

announcements. News can be viewed in a list.   

Selected news articles can be chosen as “featured news” which will display at the top of the news list, on 

your group landing page, and on other pages referencing the news page. 

All news items require a title, and a lede (or teaser) about the news item. Additional options include 

adding an image or slideshow and deck (or introduction). 

News items can be categorized into three types of news including: announcement, news post, and press 

release. 

. A NEWS ITEM DISPLAYING ALL OPTIONS FOR THE 

NEWS CONTENT PAGE 

 

 

 

* Denotes required information 

  

A NEWS ARTICLE FEATURED ON THE GROUP 

LANDING PAGE. 
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Navigating to the News Page 

1. From the My Workbench page, select the Create Content tab. 

2. Select the News link. 

 

Creating a News Page 

The Create News page displays. The Lede tab is selected by default. 

 

1. On the Lede page complete or review the fields. For additional information on how to use the text 

editor see Using the WYSIWYG Text Editor. 

Lede Fields Description 

Title (*) The title for the news item. 

Lede (*) The lede is a teaser for the news item.  

Text format This field allows you to select the text format for your lede.  

Lede image The lede image is the image that displays along with the lede (teaser). Use the 

Select Media button to select an image from one of the available libraries. 

(*) = Required   
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2. Select Deck and Body and complete and or review the following fields: 

 
 

Deck & Body Fields Description 

Deck This is an optional field that displays information above the main body 

of the page. 

Text format This field allows you to select the text format for your deck and body. 

Deck image The deck image is the image that displays along with the deck. Use 

the Select Media button to select an image from one of the available 

libraries. 

Deck image caption Enter a caption for the deck image.  

Body This is an optional field. The body is the information that highlights 

and describes the news item. 
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3. Select Misc, select and or review the following: 

 

Misc Fields Description 

Date The date the news item was posted or should be filed as posted. Select the 

date field to choose from a calendar. Use military time when entering time. 

Expire Date Date the news item will stop from being listed on the News Page or 

Featured News Page. 

Banner Slideshow Select the banner slideshow that should be shown on this page. A blank 

slideshow can be used if you do not want any slideshow on this page. This 

slideshow is the rotating images that appear at the top of a page.  

“Read More” 

replacement 

Insert accessible text to replace the automatically generated “read more” 

link that displays on the news listing page. 

 

4. Select Groups and complete the following: 
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Groups Field Description 

Groups audience (*) This is a required field. Use the dropdown to specify which group this 

news item is visible. If you only have access to one group, then that 

group will appear by default.  

(*) = Required  
5. Select Menu settings. 

  

Menu Settings  Description 

Menu settings checkbox Checking this box adds a menu link.  

 

6. Select Flags. 
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Flags setting Description 

Feature this checkbox Checking this box features the most recent news item on 

landing pages.  

7. Select Revision information. 
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Revision Information Field Description 

Change State (*) This dropdown is used to select the revision status: Draft or 

Needs Review. What appears in this dropdown is 

determined by your permissions.   

(*) = Required 

 

 

 

 

8. Select the Save button to save and view the content you just created. 

Sharing a News Article with Another Group 

There is a lot of news throughout campus and you may want to share that news on your News Listing 

page from a different area. Sharing a news article will display another group’s news on your News Listing 

page. 

 

*Please note that if a news article is shared with another group and the group deletes the 

article, it will be permanently deleted.  

1. Log in to Web-One. 

2. Select the My Workbench button. 

3. Select the News link from the Create Content tab. 

4. Insert a Title and all other required and pertinent information about your news article. In the 

Invite Groups tab, select the groups you want to share your news article with. To select more 

than one group, hold the Ctrl key down.  

NOTE: The News must be published for other departments to view and add the article to their 

News listing page. 

 
Note: The group admin for the group/s selected do not get email notifications indicating that a news 
article has been shared. Please contact them directly to let them know. They must manually go into their 
Group tab > News Sharing Invitations to accept the news. 
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Sharing an Existing News Article 

1. While logged in, open up the published news article you want to share and select the Edit Draft 

tab.  

2. Select Invite Groups from the menu on the left.  

3. Select the group that you want to share the news with. Hold the Ctrl key down while selecting to 

share with more than one group.  

4. Select the Save button.  

Note: The group admin for the group/s selected do not get email notifications indicating that an news 

article has been shared. Please contact them directly to let them know. They must manually go into their 

Group tab > News Sharing Invitations to accept the news.  
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CREATING A GENERAL PAGE 

The Page content type is used for general content that is not one of the other categories such as Event, 

News, Video, or Slideshow.    

A page content type is likely to be used for a Group landing page or other webpages where general 

information is displayed.    

The page content type should be used when displaying content using the accordion style layout (also 

known as multi-body page), which has headings that expand and collapse content. See the multi-body 

section below. 

 

 

  

 

  

A GENERAL PAGE DISPLAYING ALL OPTIONS. 

*Denotes required information 
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1. From the My Workbench page, select the Create Content tab. 

2. Select the Page link. 

 

 

Creating the Page 

The Create Page displays. 

1. By default, the Body tab displays. Enter the information (as needed) into the fields. For 

additional information on how to use the text editor see Using the WYSIWYG Text Editor. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Page Info Fields Description 

Title (*) The title for the event.  

Body The body is the information that describes the content of page. 
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(*) = Required  
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2. Select Misc and select the following: 

 

 

Misc Fields Description 

Banner Slideshow Select the banner slideshow that should be shown on this page. A 

blank slideshow can be used if you do not want any slideshow on this 

page.This slideshow is the rotating images that appear at the top.  

 

3. Select Groups: 

 

 
 

Misc Fields Description 

Groups audience (*) Use the dropdown menu to specify which group this page applies. If 

you only have access to one group, then that group will appear by 

default.  

(*) = Required 
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4. The multi-body section of Page is an optional way to display content in a collapsible format 

called an accordion style (refer to the Creating A General Page Section to view an accordion). 

Select Multi-Body and enter the information (as needed) into the fields. 

5. Select the Add another item button to create a heading (or accordion). 

Multi-Body Fields Description 

Multi-body Title This multi-body title displays as the header of the content. When 

the header is selected, the content will expand/collapse to view 

additional information.    

Multi-body Body Enter additional information for that displays below the header 

when expanded. 

 

6. Select Menu settings.  
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Menu Settings  Description 

Menu setting checkbox Checking this box adds a menu link.  

 

7. Select Revision Information. 

 

 

 

 

 

 

 
 

Revision Information Fields Description 

Change State (*) This dropdown is used to select the revision status: Draft, 

Needs Review or Published). What appears in this 

dropdown is determined by your permissions.   

 (*) = Required 

 
8. Select the Save button to save and view the content you just created.  
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LINKING TO A VIDEO 

Using a video content type enables you to post a video viewable to the public. Videos are not uploaded 

to Web-One; instead, content owners insert a link to a video that resides on any video hosting site   

elsewhere (e.g. YouTube). The video content type requires a title, a URL to link to the video, and a video 

transcript. Additional options include video caption, deck (or introduction) and the ability to customize the 

URL alias. 

A VIDEO PAGE DISPLAYING ALL OPTIONS  

 

 

 

 

 

* Denotes required information 
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Navigating to the Video Page 

1. From the My Workbench page, select the Create Content tab. 

2. Select the Video link. 

 

 

Creating a Video 

The Create Video page displays. The Video tab is selected by default. 
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1. On the Video page complete and or review the following fields:  

Video Fields - Part I Description 

Title (*) The title for the video page. 

Video(*) The video that will be publicized on the video page. 

(*) = Required  

2. Select the Select media button to add a video. 

 
 

On the popup window, select the Web tab and complete the following field:  

 

Note: Videos must be uploaded to YouTube prior to adding it to the system. YouTube videos with the 

embedding option disabled will not be uploaded successfully. 

Select Media Field Description 

URL or Embed code (*) This URL is the address of the webpage. To acquire an accurate 

URL for the video, navigate to the YouTube video you desire to 

upload. Copy the address from the browser and paste it into this 

field.  

(*) = Required  
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3. Select the Submit button to upload the video and to return to the Video page. Select and or 

review the following fields: 

Video Fields - Part 

II 

Description 

Captioned checkbox Checking this box add the captions embedded within the uploaded video. 

You must confirm whether or not the captions are enabled. 

Video caption This is an optional field. Caption is a short explanation or a description of 

the content of the video shown below the uploaded media. 

 

4. Select Deck and Transcript and complete and or review the fields. For additional information on 

how to use the text editor see Using the WYSIWYG Text Editor. 

 
 

Deck & Video 

Transcript Fields 

Description 

Deck This is an optional field that displays information above the video 

display. 

Text format This field allows you to select the text format for your deck and video 

transcript. 

Video Transcript (*) The video transcript field is a required field. Transcript is the written 

version of the audio contained within the uploaded video. It gives the 

video a searchable and an accessible functionality. 

(*) = Required 
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5. Select Misc, select and or review the following: 

Misc Fields Description 

Date The date the video item was posted or should be filed as posted. Select 

the date field to choose from a calendar. Use military time when entering 

time. 

Banner Slideshow Select the banner slideshow that should be shown on this page. A blank 

slideshow can be used if you do not want any slideshow on this page. 

This slideshow is the rotating images that appear at the top of a page.  

 

 

6. Select Groups: 

 

Groups Field Description 

Groups audience (*) This is a required field. Use the dropdown to specify which group this 

video item is visible. If you only have access to one group, then that group 

will appear by default.  

(*) = Required 
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7. Select Menu settings. 

  

Menu Settings  Description 

Menu setting checkbox Checking this box adds a menu link.  

 
8. Select Revision information. 

 

Revision Information Field Description 

Change State (*) This dropdown is used to select the revision status: Draft or 

Needs Review. What appears in this dropdown is determined by 

your permissions.   

(*) = Required 
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9. Select URL path settings. 

 

URL Path Settings Description 

Generate automatic URL alias checkbox Checking this box adds an automatic URL alias. 

The URL alias provides a more understandable 

path name to the content.  

URL alias This field is used to manually add a customizable 

URL alias for the video page. 

 

10. Select the Save button to save and view the content you just created.  
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CREATING A GALLERY CAROUSEL 

A Gallery Carousel is content type that can display multiple images on a webpage as thumbnails, along 
with the gallery carousel. The carousel action uses a forward and back button to sort through the images. 
Selecting an image displays the image in a larger view.  
 
The Gallery Carousel stands alone as a content page that follows a template. The carousel will always 
display at the bottom and the content above it. You can link to this page just like any other page in Web-
One.  

 

Navigating to the Gallery Carousel Page 

1. From the My Workbench page, select the Create Content tab. 

2. Select the Gallery Carousel link. 
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Creating a Gallery Carousel 

The Create Gallery Carousel page displays. The Menu Settings tab is selected by default. 

1. On the Menu Settings page, complete or review the fields.  

Menu Settings 

Fields 

Description 

Title (*) The title for the webpage. 

Group Audience Select the group you are creating the webpage for. 

If you do not select a group, you will  not be able to 

retrieve your gallery carousel page. 

Body The body is the information that describes the 

content of the page.  

Select media button Select the media button to insert an image into the 

gallery carousel. 

Add another item Adds another image to the gallery carousel. 
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2. Select the Revision information tab. 

 
 

Revision Information Field Description 

Change State (*) This dropdown is used to select the revision status: Draft or 

Needs Review. What appears in this dropdown is determined by 

your permissions.   

 
3. Select URL path settings. 

 

URL Path Settings Description 

Generate automatic URL alias checkbox Checking this box adds an automatic URL alias. 

The URL alias provides a more understandable 

path name to the content.  

URL alias This field is used to manually add a customizable 

URL alias for the video page. 
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CREATING AN AWARDS PAGE 

The Awards content type is used to display funding opportunities for research projects. For each 

funding opportunity available, a new awards content page is created. Awards content pages can be 

edited and maintained as needed. Faculty can view, apply and filter all funding opportunities that 

display. Your area has a main program funding webpage that displays each award available. If you 

are unsure what that page or URL is, contact your Web-One liaison. You do not need to make any 

changes or updates to the main awards webpages.  Most colleges refer to a funding opportunity as 

a program however inside Web-One it is labeled as “Award”.  

Example of program funding opportunity display: 

 

Navigating to the Awards content type 

1. From the My Workbench page, select the Create Content tab.  

2. Select the Awards link.  

Creating an Awards Page 

The Create Awards page displays. 
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1. By default, the Award Info tab displays. Enter the information (as needed) into the fields. 

Create Awards Page 

fields 

Description 

Title (*) The required title for the program name 

URL Enter a title and corresponding URL that links to information about 

sponsor/program 

Sponsor Name of organization offering the program 

Summary Brief description of the program being funded 

About Describes the program such as purpose, consideration factors, 

and highlights  
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Create Awards Page 

fields continued 

Description 

Post Date Defaults to today’s date. Change if necessary 

Sponsor Deadline Choose a date the proposal is due 

Award Ceiling Identify the total award amount 

Category Tag Optional descriptor for the award. Example: Collaborative, Limited 

Submission, and Centers & Institutes 

College Tag If the award relates to one or more colleges, check all that apply. 

This enables users to search for programs available by college 

 

2. Select the Groups tab to add the Awards content to a group or groups. This is a required field. 

 

Groups Description 

Groups audience (*) Use the dropdown menu to specify which group this page applies. If 

you only have access to one group, then that group will display by 

default.  

 

 

3. You can skip the Menu settings tab and select the URL path settings tab. If you want to 

generate a new URL for the page, this is an option, it is not required, however. 
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URL Path Settings Description 

Generate automatic URL alias checkbox Checking this box adds an automatic URL alias. 

The URL alias provides a more understandable 

path name to the content.  

URL alias This field is used to manually add a customizable 

URL alias for the video page. 

 

 

 

 

 

 

 

 

 

 

4. To enable your page to be easily found when searched, you can add keywords to the webpage. 

Select the Meta tags tab. Enter Keywords in the field. 
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Meta tags  Description 

Keywords Enter keywords that describe your page. Use 

a comma to separate  

 

5. In the Revision information tab, select the dropdown menu under Change State to change 

the state of your page. Use the optional text field below to log a message about the page.  

Note: If you have not saved your page yet, you do not see the third option to Publish the page. 
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 Revision Information Fields Description 

Change State (*) This dropdown is used to select the revision status: Draft, 

Needs Review or Published). What appears in this 

dropdown is determined by your permissions.   

6. Do not change any settings in the Comment settings tab. 

7. Select the Save button to save your Awards page. To display this award on the main program 

funding opportunities page, you must publish the awards page.  

8. Select the Revisions tab and choose Published from the Change State dropdown menu.  
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EDITING THE PERSON LIST 

The person content type lists the contact information for each employee associated with the group.    
 

Editing Information for a Person in the List: 
When a Web-One group site is created, a list of people associated with the group is also created, feeding 
from the People Finder page. The people list is automatically updated on a nightly basis to update 
changes from the People Finder data. Therefore, changes should not be made to other fields (title, email, 
phone, office location) because they will automatically be overridden with the next data feed.    
 
However, the person list offers the option to include a URL to a website or the person’s image, neither of 
which are currently in PeopleFinder. Website URLs and images will not be overridden by the nightly data 
feed.    
 

Adding a Person to the List: 
The person list also offers the option to add a new person who is not automatically associated with the 
group. If they are not part of the group, their information will not be overridden by the nightly data feed. 
  
Example #1 – Person Listing w/Photos (created by Group Admin) 
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Example #2 – Person Listing without Photos (Created by Group Admin) 

 

Note: These listing pages are created by the Group Admin for your area, but the data contained on these 

pages are pulled from People Finder, or from the Person pages created by the content creators for your 

area.  
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Example # 3 – Person Page  

 

Navigating to the Person Page 

1. From the My Workbench page, select the Create Content tab. 

2. Select the Person link.  
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Adding a New Person  

The Create Person page displays. 

 

(*) = Required 

1. In the Create Person page, complete the First Name and Last Name fields. These are 

required fields.  

2. Select the Details tab and enter the following information: 
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Details tab Description 

Type dropdown  Is this person staff or faculty? Select None, Staff or Faculty from the 

dropdown.  

Position (*) Specify this person's position title within this department or group. 

Office location (*) Enter this person's office location. This is usually a building name 

and room number. 

 

Phone  Enter this person's on-campus phone number. The number should 

be entered in this format: 818/677-0000. 

Email Enter the CSUN email address where this person can be reached. 

Website Enter the URL for this person's home page, if any. 

(*) = Required 

3. To upload a photo for this person, select the Select media button.  

a. You can choose a file to upload, or search for one under Web, Group Library or My Files. 

 

   
 

b. Once the image is found, select the Submit button to add the image to the person page.  

Note: Whether or not an image is added, will depend on the internal business process for your 

Organic Group.  

4. If the person has biography information that needs to be included, select the Biography tab. 
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5. Enter the following information: 

Biography tab Description 

Title Use this field if you want to link to existing biography information that 

is housed on another page. Enter a title or name for the link.   

URL Enter the URL for the link.  

Biography Use this section of the WYSIWYG editor to create biography text if 

none exists elsewhere. 

6. Select the Groups tab. The Groups audience dropdown displays. This is a required field. 

 
(*) = Required 

Groups tab Description 

Groups audience (*) Most users will only have access to create content for one group, but 

if you have access to more than one group, the groups that you have 

access to will display in this dropdown. Select the appropriate group 

audience.  

(*) = Required 

7. Select the Revision information tab.  
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8. Complete the following: 

Revision information tab Description 

Change State dropdown (*) This determines the status of the content you are creating 

(Draft, Needs Review, Published). The options 

available depend on your permissions. Content must be 

saved before it can be published.   

Log message Enter a message for this change (if needed). For example, 

a note to the Editor/Reviewer.    

(*) = Required 
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9. Select the URL path settings tab. 

 

10. Complete the following fields as needed: 

URL Path settings tab Description 

Generate automatic URL alias 

checkbox 

If this box is checked, the URL for the webform will be 

generated automatically. Unchecking the box, will allow 

you to enter an alias in the URL alias field.  

URL alias Enter a custom URL if you want it to be different than one 

automatically generated. You must uncheck the Generate 

automatic URL alias checkbox to enter an alias in this 

field.   

 

11. Select the Save button.  

Edit a Person 

If a person already exists in Web-One, but you need to make a change to their contact information: 

1. Log in to Web-One. 

2. Select My Workbench. 

 

3. Search for the person you wish to edit. Use the search fields and dropdown menus to narrow the 

search results.  

4. Once found, select the Edit button.  

5. Make changes as needed. Refer to the previous section for instruction. 

6. Select the Save button. 
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The webform content type allows you to create forms with fields that can be filled out by a visitor to 

your webpage.  

The webform setup requires a title, body and fields needed to capture data, along with an email address. 

When the forms are completed and submitted online, they will be automatically sent to this email 

address. 

 

 

  

WEBFORM WITH THE BASIC FIELD TYPES HIGHLIGHTED 

*Denotes required information 
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1. From the My Workbench page, select the Create Content tab. 

2. Select the Webform link. 

 

 

Creating a Webform 

The Create Webform page displays. For additional information on how to use the text editor see Using 

the WYSIWYG Text Editor. 
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1. Enter a title for the form. The Title field is required.  

2. Select the Body tab, enter the following information: 

Body tab Description 

Body In a webform, the Body field is used to add descriptive text or 

instructions for completing the form. Enter and format the text using the 

WYSIWYG editor.  

(*) = Required 

3. Select the Misc tab. The Banner Slideshow dropdown displays.  

 
(*) = Required 

4. Select a banner slideshow from the dropdown: 

Misc tab Description 

Banner Slideshow Select the banner slideshow to display on this page. If you do not 

want to include a slideshow, you must create a “blank” slideshow 

using the Slideshow content type which can then be added after the 

webform has been saved.  
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5. Select the Groups tab. The Groups audience dropdown displays. This is a required field. 

 
(*) = Required 

6. Select a group from the dropdown. 

Groups tab Description 

Groups audience (*) Most users will only have access to create content for one group, but 

if you have access to more than one group, the groups that you have 

access to will display in this dropdown. Select the appropriate group 

audience.  

(*) = Required 

7. Select the URL path settings tab.  
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8. Complete the following fields as needed: 

URL Path settings tab Description 

Generate automatic URL alias 

checkbox 

If this box is checked, the URL for the webform will be 

generated automatically. Unchecking the box, will allow 

you to enter an alias in the URL alias field.  

URL alias Enter a custom URL if you want it to be different than one 

automatically generated. You must uncheck the Generate 

automatic URL alias checkbox to enter an alias in this 

field.   

 

9. Select the Revision information tab.  
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10. Complete the following: 

Revision information tab Description 

Change State dropdown (*) This determines the status of the content you are creating 

(Draft, Needs Review, Published). The options 

available depend on your permissions. Content must be 

saved before it can be published.   

Log message Enter a message for this change (if needed). For example, 

a note to the Editor/Reviewer.    

(*) = Required 

11. Select the Save button.  

 

12. The Form components page displays. From here, you can create, edit, adjust layout, view 

results and designate an e-mail address for submission.  

 

13. In the Label column, enter a name for the first component. In this example, Name is used.  

 

14. Select Type from the dropdown. The type determines the type of data you are capturing and also 

determines how it displays on the form. Please review the table on the next page for a definition 

of types. For this example, Textfield is selected.  
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Type Definitions Description 

Date Includes controls for entering the date.  

Email This field validates the entry as an email address. 

Fieldset A grouping container; arrange controls that should be part 

of a group as sub items of the fieldset.  

File Controls for uploading a file to the site; the URL for the 

uploaded file is included in the submission email if the 

option is set.  

Grid A survey-like control with questions/items down the left 

side and responses and choices in columns on the right. 

All questions in the grid have the same options for 

response. For different sets of responses, create different 

grids.  

Hidden The label and text in the Description field are not displayed 

on the form but will be included in the data saved. 

Markup Allows you to enter custom HTML or PHP logic into your 

form.  

Number Controls for entering numbers.  

Page break Use this component to split the form into another page. If 

used, Next Page and Previous Page links display at the 

bottom of the form.  

Select Options Controls for adding one or more options as radio buttons 

in a list or group. For example, this can be used for Yes or 

No responses. For accessiblility, it is recommended that 

the listbox option be used when building this component, 

but if radio buttons are used, please refer to Appendix C 

for accessibility instructions in regards to radio buttons.  

Textarea A multi-line text field that can be sized for both height and 

width.  

Textfield A single-line text field that can be sized by width and 

maximum numbers of characters.  

Time Controls for entering the time of day.  

Cite Reference: Create/Edit a Webform, Appalachian State University, http://help.cms.appstate.edu/book/createedit-webform-components   

http://help.cms.appstate.edu/book/createedit-webform-components
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15. If the field is mandatory, select the Mandatory checkbox.  

16. Next, select the Add button to proceed to the Edit component page.  

 

The Edit component page is dynamic in that the parameters change depending on the Type 

selected (Textfield, Date, Markup, etc.). 

The following tables pertain to the most basic webform field types. The field types that fall outside of 

the information here are considered more advanced and will not be covered in this document. 

Additionally, these tables cover the critical pieces of information needed for that particualr field type 

and do not cover every field available.  

17. Complete the necessary fields for the field type selected: 

Fields for DATE Type Description 

Label (*) This field defaults to whatever label was entered when the field 

was first created.  

Field Key (*) This field defaults to whatever key was entered when the field 

was first created. However, a field key must be unique, so if 

you have another item with the same name in your form, adjust 

the field key to keep it a unique value. So if the field named 

“Job” is used more than once, you’ll need to create unique 

keys such as job1, job2, etc.  

Description Used to give the user instruction on how to complete the field.  

Start date/End date Determines the earliest and latest date that can be entered into 

the field.  

Enable pop-up calendar 

checkbox 

Checking this box adds a date picker to the form and allows 

you to select a date from a dropdown or a calendar grid.  

 

Label display dropdown Determines where the label is in relation to the entry field. The 

choices are: Above, Inline or None.  

(*) = Required 
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Fields for E-MAIL Type Description 

Label (*) This field defaults to whatever label was entered when the field 

was first created.  

Field Key (*) This field defaults to whatever key was entered when the field 

was first created. However, a field key must be unique, so if 

you have another item with the same name in your form, 

adjust the field key to keep it a unique value. So if the field 

named “Job” is used more than once, you’ll need to create 

unique keys such as job1, job2, etc. 

Description Used to give the user instruction on how to complete the field.  

Width Determines the width of the text box as it relates to character 

width (30 characters long, 25 characters long, etc.). 

Label display dropdown Determines where the label is in relation to the entry field. The 

choices are: Above, Inline or None.  

(*) = Required 

Fields for MARKUP Type Description 

Label (*) This field defaults to whatever label was entered when the field 

was first created.  

Field Key (*) This field defaults to whatever key was entered when the field 

was first created. However, a field key must be unique, so if 

you have another item with the same name in your form, 

adjust the field key to keep it a unique value. So if the field 

named “Job” is used more than once, you’ll need to create 

unique keys such as job1, job2, etc. 

Text format dropdown Select Filtered HTML from the dropdown.  

Value Enter HTML in Value field. When saved, text will display 

according to the coding you specified for it.  

(*) = Required 
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Fields for NUMBER Type Description 

Label (*) This field defaults to whatever label was entered when the field 

was first created.  

Field Key (*) This field defaults to whatever key was entered when the field 

was first created. However, a field key must be unique, so if 

you have another item with the same name in your form, 

adjust the field key to keep it a unique value. So if the field 

named “Job” is used more than once, you’ll need to create 

unique keys such as job1, job2, etc. 

Description Used to give the user instruction on how to complete the field.  

Unique checkbox Allows for unique numbers only.  

Integer checkbox Allows for integers (whole numbers only). With this checked 

numbers such as 12.34 would be invalid.  

Minimum This ensures the minimal numeric value allowed.  

Maximum Determines the maximum value as well as the width of the 

field.  

Step Used to limit options to steps or increments of a certain 

number. A step of “5” would limit options to (5, 10, and 15). 

Decimal places Automatic will display up to 4 decimals places if needed. A 

value of "2" is common to format currency amounts. 

Thousands separator Choose between comma, period, space or none. 

Label display dropdown Determines where the label is in relation to the entry field. The 

choices are: Above, Inline or None.  

(*) = Required 
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Fields for PAGE BREAK 

Type 

Description 

Label (*) This field defaults to whatever label was entered when the field 

was first created.  

Field Key (*) This field defaults to whatever key was entered when the field 

was first created. However, a field key must be unique, so if 

you have another item with the same name in your form, 

adjust the field key to keep it a unique value. So if the field 

named “Job” is used more than once, you’ll need to create 

unique keys such as job1, job2, etc. 

Next page button label This is used for the Next Page button on the page before this 

page break. Default: Next Page > 

Previous page button label This is used for the Prev Page button on the page after this 

page break. Default: < Prev Page 

(*) = Required  
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Fields for SELECT OPTIONS 

Type 

Description 

Label (*) This field defaults to whatever label was entered when the field 

was first created.  

Field Key (*) This field defaults to whatever key was entered when the field 

was first created. However, a field key must be unique, so if 

you have another item with the same name in your form, adjust 

the field key to keep it a unique value. So if the field named 

“Job” is used more than once, you’ll need to create unique 

keys such as job1, job2, etc. 

Description Used to give the user instruction on how to complete the field. 

Options (*) The options listed here appear as radio buttons or listbox 

options. An example of this could be an Employee Status field 

that lists Faculty, Staff or Student as an option.  

 

Options must be keyed in this format: 

“safe_key”|”some readable option” 

To create the options you see above, options would be entered 

this way: 

faculty|Faculty 

staff|Staff 

student|Student 

Use of alphanumeric characters and underscores is 

recommended in keys.  

One option per line.  

Listbox checkbox Select this box if you want the component to be displayed as a 

listbox instead of the default radio buttons.  

Label display dropdown Determines where the label is in relation to the entry field. The 

choices are: Above, Inline or None. 

(*) = Required  
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Fields for TEXTAREA Type Description 

Label (*) This field defaults to whatever label was entered when the field 

was first created.  

Field Key (*) This field defaults to whatever key was entered when the field 

was first created. However, a field key must be unique, so if 

you have another item with the same name in your form, 

adjust the field key to keep it a unique value. So if the field 

named “Job” is used more than once, you’ll need to create 

unique keys such as job1, job2, etc. 

Description Used to give the user instruction on how to complete the field. 

Width Determines the width of the text box as it relates to character 

width (30 characters long, 25 characters long, etc.). 

Height Determines the height of the textarea box as it relates to row 

height. Below is a textarea box with a row height of 3: 

 

Resizable checkbox Selecting this option makes the text area resizable. 

(*) = Required 

Fields for TEXTFIELD Type Description 

Label (*) This field defaults to whatever label was entered when the field 

was first created.  

Field Key (*) This field defaults to whatever key was entered when the field 

was first created. However, a field key must be unique, so if 

you have another item with the same name in your form, 

adjust the field key to keep it a unique value. So if the field 

named “Job” is used more than once, you’ll need to create 

unique keys such as job1, job2, etc. 

Description Used to give the user instruction on how to complete the field. 

Maxlength Maximum length of the textfield value. 

Width Determines the width of the text box as it relates to character 

width (30 characters long, 25 characters long, etc.). 

Label display dropdown Determines where the label is in relation to the entry field. The 

choices are: Above, Inline or None. 

       (*) = Required 
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18. Once the Edit component page is complete, select the Save component button at the bottom 

of the page.  

The Webform tab and corresponding page displays: 

19. Use the View tab to view the form as an enduser will see it.  

Here is an example of the form after selecting the View tab: 

 

 

20. To make changes to the Body, select the Edit Draft tab. 

21. To make changes to the form fields, select the Webform tab. 

22. To change revision status, select Revisions, choose the appropriate option from the Change 

State dropdown and select the Update State button.  

23. Select the Results tab to view results. Results will be covered in the Viewing and Downloading 

Webform Results section of the Webform instructions.  

24. Use the Panelizer tab to adust the layout of the webform page itself. View the Panelizer section 

in this guide for more information.  
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Conditional Formatting of Fields 

There may be times when you want some fields to display and other fields to remain unseen based on 

how a user responds to a field.  

For example: 

Question 1 asks: Are you a student? (Yes or No) 

Question 2 asks Undergraduate or Graduate? 

If the answer to Question 1 is NO, then you can edit the settings so that Question #2 does not display.  

To set-up Conditional Formatting: 

1. Open the webform. 

2. Under the Webform tab, select the Conditionals button. 

 

3. To add a new condition, select the plus sign (+).  

 

4. The conditional setting window displays.  

 

5. The dropdowns will display fields from your form. Use the dropdowns to select the fields you want 

to configure (If, then, etc.). 

6. If you want to add or delete a condition, use the plus and minus buttons as needed.  

7. Select the Save conditions button to complete the process.  
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Setting E-Mail Address for Submit Button on a Webform 

The benefit of webform submission is that the form data, once submitted, goes directly to the content 

owner. Webform creators can specify one or more emails addresses for this purpose.  

1. Open the webform. 

2. Under the Webform tab, select the E-mail button. 

3. Enter an email address in the Address section. 

4. Select the Add button to add the address to the form.  

 

5. Complete the fields as needed on the Edit e-mail settings page.  
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6. Select the Save e-mail settings button at the bottom of the page. 

7. Review the entry and edit as needed.  

8. To add additional addresses, repeat steps 2-6. 

Viewing and Downloading Webform Results 

Once submitted, form entries can be viewed or downloaded. 

1. Open the webform. 

2. Select the Results tab.  

 

3. Select the View tab to view the detail behind each entry, or select the Table button to view the 

form data in table form.  

4. To download the data, select the Download button.  

 

 

5. Select the Export format. There are two options: Delimited text or Microsoft Excel.  

6. Select the Download button to download the results.  

Note: Advanced formatting options are available. Use the advanced options as needed.  
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SETTING UP AN EVENT LISTING FOR A GROUP 

Group Administrators who also have the Content Publisher, Editor or Creator role can add an event 

listing to an existing page. This listing displays events, items noted with a date and time, as a list.  

Inserting an Event Listing on a Page 

Listings are placed on a Page content type.  

1. Log in to Web-One.  

2. Select My Workbench. 

3. From the Site Content tab, search for and select the page you want to add the event listing to.  

      

4. Select the Panelizer tab.  

      

5. Select the content link.  
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6. In the Content container, select the gear icon in the container’s upper left-hand corner. 

7. A popup menu displays. Select Add content. 

       

8. The Add content to Content window displays. Select View panes.  

        

9. The event list options display as views. Select an option from the list. This determines the type of 

list displayed. 

        

10. The configuration screen displays for the view selected. Select Group from the OG 

membership: Group ID dropdown menu. 

        

11. Select the Finish button. 

12. In Panelizer, select the Save button to save the configuration. 

  



TEST 

 
SETTING UP A NEWS LISTING FOR A GROUP 

Web-One Essentials - User Guide      Page 96 of 127 
12/04/19         

 

Group Administrators who also have the Content Publisher, Editor or Creator role can add a news listing 

to an existing page. This listing displays content that has been created using the News content type.  

Inserting a News Listing on a Page 

Listings are placed on a Page content type.  

1. Log in to Web-One.  

2. Select My Workbench. 

3. From the Site Content tab, search for and select the page you want to add the news listing to.  

      

4. Select the Panelizer tab.  

      

5. Select the content link.  
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6. In the Content container, select the gear icon in the container’s upper left-hand corner. 

7. A popup menu displays. Select Add content. 

       

8. The Add content to Content window displays. Select View panes.  

        

9. Select View News Teaser List: Main. 

        

10. The configuration screen displays for the view selected. Select Group from the OG 

membership: Group ID dropdown menu. 

        

11. Select the Finish button. 

12. In Panelizer, select the Save button to save the configuration. 
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Group Administrators who also have the Content Publisher, Editor or Creator role can add a person or 

employee listing to an existing page. This listing displays employee contact information. 

Inserting a Person Listing on a Page 

Listings are placed on a Page content type.  

1. Log in to Web-One.  

2. Select My Workbench. 

3. From the Site Content tab, search for and select the page you want to add the person listing to.  

      

4. Select the Panelizer tab.  

      

5. Select the content link.  

      

6. In the Content container, select the gear icon in the container’s upper left-hand corner. 

7. A popup menu displays. Select Add content. 
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8. The Add content to Content window displays. Select View panes.  

        

9. Select View Person Teaser: No Photo or View Person Teaser: With Photo. 

        

10. The configuration screen displays for the view selected. Select Group from the OG 

membership: Group ID dropdown menu. In this example, OG stands for Organic Group. 

        

11. Select Faculty or Staff. To select more than one value, hold down the Shift key on your keyboard 

while selecting the additional value.   

12. Select the Finish button. 

13. In Panelizer, select the Save button to save the configuration. 

 

  



TEST 

 

Web-One Essentials - User Guide      Page 100 of 127 
12/04/19         

 

FINDING CONTENT TO EDIT 

Use My Workbench to find the content you want to view, edit or change.  
 
After logging in to Web-One and selecting My Workbench, the Site Content tab should be open by 
default.  The search box in the upper left-hand corner of the page enables you to search for content by 
title, filter by content type and year published.  Once you see the title of the content you want, click on the 
link to access and edit the content.   
 
To view, edit or make other changes, you must first find the content in question. To search for content: 

1. Log in to Web-One. 

2. Select  from the upper, left-hand corner of the page.  

My Workbench displays: 

     

3. If known, enter the title of the page in the Title field. This field can also be left blank. 

       

4. Select a content type from the Type dropdown menu. In this example, “Webform” was selected. 

Selecting a specific content type will return results only for that particular content type.  

5. In the Published dropdown, select Any, Yes or No. For example, selecting “Yes” will only 

display published content.  

6. In the Items per page dropdown, select 10, 25, 50, 100 or 200.  

7. Select the Apply button to apply these parameters and to view the results.  

8. Select column headings to sort results by column.  

      

9. To search for additional content types, repeat steps 3-7. 
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PUBLISHING CONTENT  

Completed content must be published in order to be visible to the public. Content will always be in one of 

three states: 

 Draft 

 Needs Review 

 Published 

Draft 

This is the default state when any/all content is created. When content is in the Draft state, it means that 

the content creator is still working on the content and is not yet finished with it.  

Needs Review 

When the content creator is finished working on the content, the content creator changes the state to 

Needs Review. This allows editors and publishers to review the content.  

Published 

Content in the Published state is viewable by everyone, whether logged into the system or not.  

Finding Content that is Ready for Publishing 

Once the content is in a Needs Review state, the Publisher can then search for content that is ready for 

review: 

1. Log in to Web-One. 

2. From My Workbench, select the Needs Review tab.  

 

3. Select the Change editorial state link for the content you want to publish.  

4. Select the Published radio button. 

 

5. If desired, enter a message into the log message window.  

6. Select the Update State button to save the change.  

7. If there is additional content to review/publish, repeat steps 2-6. 

Note: If content was published in error, the state can be changed back to Needs Review or Draft as 

needed.   
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GOOGLE ANALYTICS 

Web-One integrates the Google Analytics tool to provide information about the visits (or traffic) and 

usage of the webpages associated with your group. This report will be run by the Web-One Administrator 

and sent to the Group Administrator weekly.  

 

The Google Analytics Summary page displays the following information: 

 Visits 

 Pageviews 

 Pages/Visit 

 Bounce Rate 

 Average Time on Site 

 % New Visits and Top Pages 
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CHECKING FOR BROKEN LINKS 

Broken links exist on webpages when an incorrect URL is inserted or an internal or external webpage 
that you are linking to has been removed or moved.    
 
Web-One provides two ways to check for broken links.  When content is being entered into the 
WYSIWYG editor, content creators will be able to see when a link is broken in the WYSIWYG editor 
because a broken link message with the broken link will appear above the body of the WYSIWYG.  
 
Web-One also provides a Broken links report to display a list of broken links.    

1. To access the Broken links tool, log in to Web-One. From the main login page, select the 

Reports tab. 

 

The Broken links summary displays. The page includes Error reasons and Operations to fix the broken 

link. Select the Edit link settings link to correct the broken link. 
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UNIVERSAL DESIGN AND ACCESSIBILITY 

Web-One allows you to enable universal design features in your webpages according to principles that 
ensure content is useable and accessible.    
 
Current universal design features within Web-One include:  

 Alternative text descriptions for non-text elements. For specific instructions see Adding on page 
105 

 Structural markup to identify headings.  

 Each field in a form has a label associated with it. 

 Tables with association of all data cells in a data table with headers. Table headers can be 
inserted so that data in the table is associated with a label. For specific instructions see Inserting 
Tables with Headers on page 112 
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According to content owner access, each designated content owner has the ability to edit content. 
Editing content can be done in the Draft or Needs Review status. Also, after the content is published, it 
can be edited by a Publisher.  

Searching for Content Pages to Revise and Edit 

To revise or edit content pages, see the Finding Content to Edit section. Select the content page and 

navigate to the area that needs revised or edited. The WYSIWYG editor displays in the main content 

areas of the webpage. 

Using the WYSIWYG Text Editor 

The acronym for WYSIWYG stands for What You See Is What You Get. Web-One uses a WYSIWYG 

text editor so you can view the content page the same way it looks when published. This allows users 

with no knowledge of programming language to create webpages. 

 

However, the WYSIWYG text editor in Web-One also allows users with advanced knowledge to switch to 

an HTML (hypertext markup language) editor to write webpages in HTML code. 

Adding/Uploading Files  

The WYSIWYG editor includes many of the same functions you find in Microsoft products such as Word 

or Excel. It includes the ability to add images, videos, documents, pull quotes and call to action buttons.  

1. Select the Add Media link. 

2. The media window displays with a series of buttons. To insert new media, select the Browse 

button and choose a media file. Options for media files include images, audio files, and 

documents. Choose an file from your computer and select the Upload button, followed by the 

Submit button. 
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Add Media buttons Description 

Web Enter a valid URL to embed a video on your page. A valid URL 

should begin with http://  

Group Library Used to select previously uploaded files from all users in your 

group. Use this library with caution. If a user deletes the file 

you are using, a broken image or video will display on your 

page. 

My Files Displays a list of files you uploaded. 

 

3. In the OG_GROUP_REF section, enter the name of the organic group that this file belongs to. 

Once you begin typing, the organic groups that you have access to display. Select the 

appropriate organic group. This is typically the group that you belong to.  

4. Select the Save button. .  

     

5. Select the Submit button to continue. 
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6. Once added, a thumbnail for the file displays in the WYSIWYG body and the file has been 

uploaded to the file list.  

      

7. This thumbnail can be kept or deleted. If kept, a user can select the thumbnail to view the file. Or, 

the thumbnail can be deleted and a URL can be added that links directly to the file in the file list.  

Note: to link to a file in the file list, find the file in the file list, hover over the file with your mouse, the URL 

for the file displays at the bottom left of your screen. Right-click to copy the shortcut or link address and 

then use that address when linking to the file.  

Inserting a Text Hyperlink 

1. To locate the URL of a file you want to hyperlink, go to the MyWorkbench button, followed by the 

File List tab. 

2. Select the file you want to link to. (E.g. a .pdf file) 

3. Selecting the file will open the file in a browser. Copy the URL in the browser. (Ctrl + C) or right-

click your mouse, and choose Copy. 
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4. Navigate and open your webpage to insert the hyperlink. In the WYSIWYG Editor (or Body) 

section, highlight or type the text where you want the hyperlink to display. Select the Insert/Edit 

Link button.  

5. In the Image URL field, paste the file hyerlink. If necessary, include the HTML Title text 

description. 

6. Select the Insert button. Your hyperlink displays on your page. 

 

Adding Alt Text to an Image 

8. If you upload an image file, include alternate text for accessibility. Enter the text in the HTML Alt 

field (HTML Title is optional). The text entered displays when a user hovers over the online 

image. Select the Save button.\ 
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9. Once the file is uploaded into the WYSIWYG, you must re-enter the HTML Alt text and HTML 

Title. From the WYSIWYG Editor, select the file with your cursor and select the Insert/Edit 

Image button. 

 

10. In the Insert/Edit Image button dialog box, re-enter the HTML Alt and HTML Title information. 
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Adding a Pull Quote 

1. Select the Insert Predefined Template Content button. 

2. The Insert Predefined Template Content window displays. Select the Pullquote option from 

the dropdown menu, followed by the Insert button. 
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3. A pull quote fits best with a minimum of five lines of text. Once the pull quote is inserted, replace 

the text by typing over the text. 

 

Adding a Dropcap 

1. Select the Insert Predefined Template Content button. 

2. The Insert Predefined Template Content window displays. Select the Dropcap option from 

the dropdown menu, followed by the Insert button. 

3. Replace the text with the dropcap letter of your choice. 

 

Adding a Call to Action Button 

1. Select the Insert Predefined Template 

Content button. 

2. The Insert Predefined Template Content 

window displays. Select the Call to Action option 

from the dropdown menu, followed by the Insert 

button. 

3. Place your cursor in the middle of the button text 
and replace the text. 

 
Note: If you experience problems, try a different browser 
or use the filtered HTML option to insert the wording.   
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Inserting Tables with Headers & A Table Caption 

For accessibility, it is important to mark your tables with headers and identify the body. It is also 
important to insert a caption for the table.  
    

1. In the WYSIWYG editor, select the Insert/Edit Table button.  
 

2. Identify the number of rows and columns you want and check the Table Caption checkbox. This 
checkbox must be checked and will add a row to the top of your table. You must then enter a 
caption, describing the type of table it is, into that space.  

     

      
 

3. Select the Insert button to insert the table into the body of your page.  
 

4. Highlight the header of your table and select the Table Row Properties button. 
 

5. Select Header from the RowType dropdown menu followed by the Update button. 
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6. Highlight the header cells in the header row and select Table Cell Properties. Change the Cell 
Type from Body to Header. Select OK. 

7. Identify the body of the table by highlighting the body. In Table Row Properties, select Body 
from the dropdown menu.  

        
8. After the table data has been created, go to that top row that was added when you checked the 

Table Caption checkbox and enter a caption for your table. Below, is an example of a table with 
headers and a caption.  

 

       
 

9. Save the page.  
 

Inserting and Editing Images 

The Insert/Edit Image button  in the WYSIWYG editor allows the user to insert an image and 

change its properties, alignment, border, spacing, dimensions and more.  

1. Select the Insert/Edit Image button. Or highlight a preexisted image and then select the 

Insert/Edit Image button. 

2. The Insert/Edit Image window dispalys.To insert a new image, copy the image URL and paste it 

in the Image URL field. 

General Tab Fields Description 

Image URL Enter a valid URL to embed an image on your page. A valid 

URL should begin with http://  

Image Description Used to add extra information about the newly embedded 

image. 

Title Displays a title when you hover over the image. 

 

3. Select the Appearance tab to customize the position and the display of the inserted image. 
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Appearance Tab Fields Description 

Alignment Define the inline float properties of your image. 

Dimension Enter the desired width and height of your image. By default, 

your image’s aspect ratio is locked and changing the value will 

change its height commensurately. 

Vertical Space  

and Horizontal Space 

Define the inline margin properties of your image. 

Border Defines the width of the border around the inserted image. 

 

4. Select the Insert button if you added a new image or the Update button if you edited an image. 

Heading Styles 

The Styles dropdown menu  from the WYSIWYG editor’s toolbar provides the 

user with headline styles that gives extra control over text formatting. It’s important to use these styles, 

when possible, so that the formatting stay consistent across the site. To add a headline style to your text, 

highlight the text you wish to make a heading and then choose the desired style option. 

Headline Options Style Display 

p 

 

h2 

 

h3 
 

h4 
 

h5 
 

h6  
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SEARCH ENGINE OPTIMIZATION 

Each webpage you create in Web-One includes a Meta tags section. Meta tags provide information to a 

search engine (such as Google) on the keywords or phrases contained in the webpage. These keywords 

or phrases then become what a visitor to your site might use to search your website. This process is 

called Search Engine Optimization, in other words, making your webpage searchable.  

By default Web-One uses the Description and Title fields on this tab to create searchable keywords for 

your webpage. You can replace the Description and Title with new information for searching.  
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APPENDIX A 

Web-One Content Owner Roles and Responsibilities  

Web‐One is CSUN's unified approach to improve accessibility and navigation and increase consistency 
to CSUN’s web presence through the use of templates, guidelines, and web design standards. Using a 

web content management system in Web‐One should make it easier to keep content current on the 
CSUN website. Web‐One has identified four campus user roles and each role has a different set of 

permissions within a group. A Group in Web‐One can be a department, college, or division (e.g. Math, 
Humanities, Information Technology). The campus Web‐One liaisons will work with each department, 
college, and division to identify the appropriate individuals in their respective areas and assign roles that 
mirror their area of responsibility. Note that a person may be assigned multiple roles and each group 
administrator can determine the appropriate use of roles for their area. For example, a small department 
may choose to assign one person (plus backup) to serve as the publisher and group administrator for 
their department, without additional content creators or editors. An overview of the permissions in each 
role is listed below.  
 
Content Creators  

 Create and customize page layout (e.g.one, two or three column layout choice, banner slide show 
images) 

 Create and edit events, news items, videos, web forms, banner slide shows 

 Upload files (e.g. PDFs) 

 Ability to edit content that they have created themselves   

 Created content by this role will be submitted for review by editors and publishers 

 This role cannot publish content to the website 
 

Editors  
All privileges of content creators listed above plus: 

 Ability to edit any content they have created as well as any other content within their Web-One 
group.    

 Content created and edited by this role will be submitted for review by publishers 

 This role cannot publish content to the website  
 

Publishers  
All privileges of content creators and editors listed above plus: 

 Publish content for their Web-One group 

 Setup primary and (optional) constituency navigation links for the Group 
 
Group Administrators  

 Assign a name for their Web-One Group (i.e. English or Humanities) 

 Assign roles to others in the Group 

 Assign a theme for the Group (initial Groups will use the initial CSUN Theme 1) 

 Setup secondary and tertiary wordmarks, primary and (optional) constituency navigation links for 
the Group 

 Setup Group defaults for news, events, banner, etc. 

 Establish Group hierarchy and URL path   

 Receive Google Analytics reports for the group site 

 This role cannot create, edit, or publish content to the website  
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APPENDIX B 

Exercise #1 – Create a Page  

1. Select My Workbench. 

2. Select the Create Content tab. 

3. Select Page. This is what you will be creating: 

 

Sample Page 

        

1. Enter the Title “User # - Test Page”. Use your own user number so you will be able to find your 

page later (see above). 

2. In the Body, insert the heading of: 

 

     Students, Faculty, and Staff   (use h3 from the styles dropdown) 

3. Add additional Body text by inserting the following: 

 

IT looks forward to supporting your technical needs this semester. To get the latest updates on 

several key projects, view our semester newsletter, What's New in IT. 

Hint: Highlight the text you want to create a hyperlink for and then use the Insert/Edit Link button to add 

the hyperlink. 

  

http://www.csun.edu/it/whatsnew.pdf
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Note: Use this URL for the What’s New in IT link: 
 
 http://web-one-training.csun.edu/sites/default/files/whatsnew.pdf 
 

4. Save the page.  

5. Go to the Revisions tab and select Published from the Change State dropdown.  

6. Enter a note in the Log message field. (Example: I made the change we talked about.) 

7. Select the Update State button to update the status and publish the page.  

  

http://web-one-training.csun.edu/sites/default/files/whatsnew.pdf
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Exercise #2 – Using Panelizer to Add Side Blocks  

4. Select My Workbench. 

5. Search for the page you created in the previous exercise.  

a. If you don’t see it right away, enter search parameters to narrow the search. 

6. Select the page by selecting the link for the page.  

7. Select the Panelizer tab. This is what you will be creating: 

 

Sample Page w/ Side Blocks Added 
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8. From Panelizer, select the content link.  

9. Select the Gear button for the left sidebar.  

10. Select Add content.  

11. There are three links titled Side Blocks. Select the THIRD Side Blocks link in that list.  

12. Select the existing side block title “Contact Us – Main”. 

13. Select the Finish button to add the side block.  

14. Select the Save button in Panelizer to save the change.  

15. Select the Preview button (scroll down to view the preview). 

Now create a new side block with two links: 

1. From Panelizer, select the content link.  

2. Select the Gear button for the left sidebar.  

3. Select Add content.  

4. Select Side Block link (last option on left, different than the option used previously). 

5. In the Body section, add two links: 

a. About IT - Use this URL: 

http://www.csun.edu/it/about) 

b. What’s New in IT - Use this URL: 

http://web-one-training.csun.edu/sites/default/files/whatsnew.pdf 
 

6. Select the Finish button to add the new side block.  

7. Select the Save button in Panelizer to save the change.  

8. Select the Preview button to preview the change.  

9. Select the View tab to view it as a published page. 

 

Your page should now have two side blocks under the left sidebar. 

  

http://www.csun.edu/it/about
http://web-one-training.csun.edu/sites/default/files/whatsnew.pdf
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1. Select My Workbench. 

2. Select the Create Content tab,  

3. Select News. This is what you will be creating: 

 

Sample Page 

 

 

4. Enter the Title “User # - Digital Stories (News Test)”. 

5. Enter this text as the Lede (teaser):  

 

Check out our new blog which showcases innovative ways in which students, faculty and staff are 

using technology. 

(Note: New blog link = http://blogs.csun.edu/digitalstories/) 

  

http://blogs.csun.edu/digitalstories/
http://blogs.csun.edu/digitalstories/
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6. Enter this text as the Body:  

 

Check out our new blog which showcases innovative ways in which students, faculty and staff are 

using technology to accomplish the teaching and learning mission of the university. Join us to 

discuss technology innovation at CSUN. 

If you have a topic idea for the blog, contact the Faculty Technology Center. 

(Note: New blog link = http://blogs.csun.edu/digitalstories/) 

(Note: Faculty Technology Center link = http://www.csun.edu/at/ftc/index.html) 

7. Save the page.  

8. While viewing the page, select the “Feature this” link to feature this news item on the group 

landing page.  

9. Go to the Revisions tab and select Published from the Change State dropdown.  

10. Enter a note in the Log message field. (Example: I made the change we talked about.) 

11. Select the Update State button to update the status and publish the page.  

 

Note: If you choose to feature a news item, that item will only appear on the group landing page if the 

group admin for the area has set-up a news listing for the group.  

  

http://blogs.csun.edu/digitalstories/
http://www.csun.edu/at/ftc/index.html
http://blogs.csun.edu/digitalstories/
http://www.csun.edu/at/ftc/index.html
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Exercise #4 – Create an Event Page  

1. Select My Workbench.  

2. Select the Create Content tab. 

3. Select Event. This is what you will be creating: 

 

Sample Page 

 

 

16. Enter the Title “User # - Lecture Capture (Test Event)”. 

17. Enter the Date and Time (start and end) for the event (shown above). Hint: use Military time.  

18. Enter the Location: Oviatt 30. 

19. Cost: leave blank. 

20. Enter a registration link: http://www.csun.edu/it/training/signups/1107leccap.html  

21. Select the Event Category: Training 

22. Enter this text as the Lede (teaser):  

  

http://www.csun.edu/it/training/signups/1107leccap.html
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Learn how you can capture your own lectures. 

 

23. Enter this text at the Body: 

 

Learn how you can capture your own lectures either in-class, at home or in-studio to enable 

students to access your lectures from home and “rewind” – a proven strategy for increasing 

learning performance. 

 

24. Save the page.  

25. While viewing the page, select the “Feature this” link to feature this event item on the group 

landing page.  

26. Go to the Revisions tab and select Published from the Change State dropdown.  

27. Enter a note in the Log message field. (Example: I made the change we talked about.) 

28. Select the Update State button to update the status and publish the page.  

 

Note: If you choose to feature an event, that item will only appear on the group landing page if the group 

admin for the area has set-up an event listing for the group.  
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In Web-One, the use of radio buttons and checkboxes create fields without labels. Therefore, when a 

webpage is read by screen reader software, an end user does not know what the field types specify. This 

is a problem when creating accessible webforms. This section provides instructions for using radio 

buttons and checkboxes in webforms. Please refer to this section when using this field type.  

 

One of the options when creating a webform in Web-One is the Select options field type. This allows 

you, the form creator, to add multiple options for a user to select. For example, Full Time and Part Time, 

as seen below: 

 

The Select options field type automatically displays options as radio buttons. If you would rather not use 

radio buttons, checkboxes can be used when building this field but both require additional configuration 

to make them accessible in Web-One.  

 

Creating Optional Radio Buttons/Checkboxes in the Select Option Field Type   

To create optional values, follow these steps: 

1. Once the body of your form has been created, select View to view your form and select the 

Webform tab to edit your webform.  

2. For ‘New component name’ enter a name for the field type you are creating. It does not matter 

what it is as it will not display. 

3. From the Type dropdown, select Select options.  

4. Select the Add button to add the component.  

5. In the Options field, enter the options or choices using the proper formatting as noted. 

6. In the Display section, under Label display, select None.  

7. Select the Save component button.  

Now, because the values listed are not accessible on their own, a Fieldset needs to be added to 

describe the values that you have just added.  

1. From the webform, select the Webform tab.  

2. For ‘New component name’ enter a name for the field type you are creating.It should provide 

some additional information such as “Select an option below:” or “Choose an option:”. 

3. From the Type dropdown, select Fieldset.  

4. Select the Add button to add the component.  

5. Enter a description in the Description field. In this example, “Are you a full time or part time 

student? Choose from the available options below.” has been entered.  

6. Select the Save component button.  

7. Click and drag th components so that the Fieldset value, is above the Select options value.  

8. On the Webform page, select the Save button to save changes.  
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9. Select the View tab to view the webform.  

10. The Fieldset value (Select an option), is now above the Select options value of Full Time and 

Part Time. See screenshot.  

 

Creating Required/Mandatory Radio Buttons/Checkboxes in the Select Option Field Type  

When creating fields, it’s possible to note the field as mandatory or required, but doing so does not flag 

the item with a red asterisk which denotes a mandatory field.  

To create accessible, manadatory values, follow these steps: 

1. Once the body of your form has been created, select View to view your form and select the 

Webform tab to edit your webform.  

2. For ‘New component name’ enter a name for the field type you are creating. It does not matter 

what it is as it will not display. 

3. From the Type dropdown, select Select options.  

4. Select the Add button to add the component.  

5. In the Options field, enter the options or choices using the proper formatting as noted. 

6. In the Validiation section, select the Mandatory checkbox.  

7. In the Display section, under Label display, select None.  

8. Select the Save component button.  

The component and options have now been added to the form, but this next step is required in order to 

make it fully accessible to a user by denoting the field with a red asterisk and adding a manual note to 

the body indicating that the asterisk denotes a required field: 

1. From the webform, select the Webform tab.  

2. For ‘New component name’ enter a name for the field type you are creating.It should provide 

some additional information. In this example, “Make a selection:” is used. 

3. From the Type dropdown, select Markup.  

4. Select the Add button to add the component.  

5. In the Value section, enter the same text that you entered as the component name. In this 

example, “Make a Selection:” but add an asterisk to the text. 

6. Make the text bold.  

7. In the Text format dropdown, switch to Filtered HTML mode.  

8. Select the Disable rich-text link. 
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9. Apply the follow code to the asterisk <span style="color: red;">*</span>. 
10. In the Text format field, flip back to WYSIWYG. 

11. Select the Save component button.  

12. Select and drag the markup component so that it is above the Select options value.  

13. On the Webform page, select the Save button to save changes.  

14. Select the Edit Draft tab.  

15. In the Body field, enter the following text: Red asterisk denotes required field.  

16. Select the Save button. 

17. Select the View tab to view the webform and its newly added asterisk and note. See screenshot.  

18. Publish form. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  




